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РУКОВОДСТВО ПОЛЬЗОВАТЕЛЯ 

NI USRP-2940R/2942R/2943R/2944R/ 
2950R/2952R/2953R/2954R 
Universal Software Radio Peripheral 

 

В этом документе описывается, как установить, настроить и проверить оборудование 

USRP-2940R, 2942R, 2943R, 2944R (NI 294x), USRP-2950R, 2952R, 2953R, 2954R 

(NI 295x). Устройства NI 294xR/5xR обеспечивают прием и передачу сигналов для 

различных телекоммуникационных задач. Комплект поставки включает 

инструментальный драйвер, используемый для программирования устройств. 

Для просмотра документации о NI 294x/5x обратитесь к меню Пуск»Все программы» 

National Instruments»NI-USRP»Documentation. 
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Рекомендации по ЭМС    
Данный продукт протестирован и соответствует требованиям и ограничениям 

электромагнитной совместимости (ЭМС), указанным в технических характеристиках. 

Эти рекомендации и ограничения обеспечивают достаточную защиту от опасного 

излучения во время использования продукта в нормальной электромагнитной 

обстановке. 

Данный продукт предполагает использование в промышленных условиях. Однако, в 

некоторых случаях возможно возникновение интерференции в результате подключения 

к дополнительным устройствам или объектам тестирования, или при использовании в 

частных или коммерческих помещениях и территориях. Для минимизации взаимного 

влияния данного продукта и теле- и радиоприемников и во избежание ухудшения 

характеристик, устанавливайте и используйте данный продукт в строгом соответствии с 

предписаниями документации.  

Кроме того, любые изменения и модификации данного продукта кроме официально 

одобренных National Instruments могут повлиять на Ваше право его использования в 

силу местных законодательных норм. 

 

Внимание Для обеспечения заявленных характеристик ЭМС, используйте 

экранированные кабели и другие аксессуары. 

 

Внимание Для обеспечения заявленных характеристик ЭМС, длина всех 

сигнальных кабелей за исключением кабелей Ethernet и кабелей антенны GPS 

не должны превышать 3 метра. 

 

Внимание Для обеспечения заявленных характеристик ЭМС, установите 

ферритовые кольца (номер продукта National Instruments 781233-01) в 

соответствии с прилагаемой инструкцией. 

 

Внимание Данный продукт не лицензирован для излучения сигналов через 

антенну, поэтому использование его с антенной может привести к нарушению 

местных законов и норм. Прежде чем использовать его с передающей 

антенной убедитесь в соблюдении местных законов и норм. 

 

Проверка системных требований   
Для успешного использования драйвера NI-USRP, к системе предъявляются 

определенные требования. 

Обратитесь к разделу readme документации драйвера, доступной на электронном 

носителе с копией программного обеспечения драйвера, или к онлайн странице 

ni.com/manuals для более детальной информации о системных требованиях, 

рекомендованных системах и поддерживаемых средах разработки. 

 

http://www.ni.com/manuals
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Распаковка   

 

Внимание Во избежание электростатического разряда и повреждения 

устройства обеспечьте заземление своего тела с помощью специального 

браслета или касанием заземленного объекта, такого как корпус Вашего 

компьютера. 

1. Прикоснитесь антистатической упаковкой металлической части корпуса 

компьютера. 

2. Снимите упаковку и убедитесь в внешней исправности устройства. 

 

Внимание Никогда не прикасайтесь к оголенным ножкам разъемов. 

 

Замечание  Не устанавливайте прибор если он выглядит поврежденным. 

3. Распакуйте остальные части и документацию. 

Храните устройство в антистатической упаковке, если оно не используется. 

Проверка комплектности 
 

 

1. Устройство NI 29xx 

2. Источник питания AC/DC и кабель питания 

3. Ферритовое кольцо 

4. Кабель SMA (m)-SMA (m)  

5. Аттенюатор 30 дБ, SMA  

6. Руководство пользователя (этот документ) 
 

 

Внимание Если Вы подключаете генератор сигналов напрямую к Вашему 

устройству, или если Вы подключаете несколько устройств NI USRP между 

собой, то следует подключать аттенюатор 30 дБ к приемным портам всех 

принимающих устройств USRP. 
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Другие необходимые элементы 

Кроме содержимого комплекта поставки Вам понадобятся следующие элементы: 

• Компьютер со свободным портом Gigabit Ethernet. 

• Если Вы планируете подключать устройство с помощью PCI Express, Вам 

понадобится интерфейсная плата MXI Express. Набор MXI Express для USRP RIO, 

содержащий интерфейсную плату, можно приобрести на ni.com. 

 

Внимание Данный продукт не лицензирован для излучения сигналов через 

антенну, поэтому использование его с антенной может привести к нарушению 

местного законодательства. Прежде чем использовать его с передающей 

антенной убедитесь в соблюдении местных законов и норм. 

Дополнительные элементы 
• Программное обеспечение LabVIEW Modulation Toolkit (MT), поставляется на 

носителе с драйвером, включает функции, примеры и документацию 

 

Замечание  Для корректной работы примеров программ c NI-USRP и 

Modulation Toolkit необходимо установить LabVIEW Modulation Toolkit. 

• LabVIEW Digital Filter Design Toolkit, включен на носителе с драйверами 

• LabVIEW MathScript RT Module, включен на носителе с драйверами 

• Дополнительный кабель SMA (m)-SMA (m) для сигналов REF IN и PPS IN  

• Кабель 1 Gigabit или 10 Gigabit Ethernet 

• GPS антенна для моделей с поддержкой привязки опорного сигнала к GPS (GPSDO) 

• Комплект NI PCIe - MXI Express Interface Kit для подключения USRP RIO к ПК 

• Комплект NI ExpressCard Slot - MXI Express Interface Kit для подключения USRP 

RIO к ноутбуку 

• NI PXIe - MXI Express Interface Kit для подключения USRP RIO к шасси PXI Express 

• Модуль распределения тактовых сигналов CDA-2990 для синхронизации 

нескольких устройств USRP 
  

Подготовка рабочего места   
Убедитесь, что условия использования устройства USRP удовлетворяет следующим 

требованиям. 

Рабочая температура  23 ±5 °C 

Рабочая влажность от 10% до 90% относительной влажности  

Степень загрязнения 2 

Максимальная высота 2000 м 

Эксплуатация только в помещении. 

 

Замечание  За более детальными характеристиками обратитесь к 

Техническим характеристикам USRP на ni.com/manuals. 
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Внимание  Не используйте NI 294x/5x вне соответствия с этим документом. 

Неправильное использование продукта может привести к поражению людей. В 

случае любого повреждения устройства может возникнуть опасность 

снижения уровня защиты. В случае обнаружения неисправности следует 

возвратить устройство в NI для ремонта. 

Установка программного обеспечения   
 

Для установки ПО Вам понадобятся права администратора на данном ПК. 

1. Установите среду разработки, например, LabVIEW. 

2. Введите код usrpdriver на странице ni.com/info  чтобы попасть на страницу 

скачивания актуальной версии драйвера устройства NI USRP. 

3. Скачайте драйвер NI-USRP. 

4. Следуйте инструкциям и подсказкам в процессе установки. 

 

Замечание  Пользователи Windows могут получать сообщения о 

безопасности и доступе в процессе установки. Примите сообщения. 

5. По окончании установки, выберите Перезагрузка (Restart) в диалоговом окне с 

выбором о перезагрузке или выключении. 
 

Установка устройств NI 294x/5x  
 

Выбор порта 
Вы можете подключить устройство USRP к Вашему компьютеру через разъем PCIe x4 

или через разъем 1G/10G ETH, которые расположены на задней панели устройства. 

Используйте кабель MXI Express с разъемом PCIe x4 или кабель Ethernet с разъемом 

1G/10G ETH. 

Для внесения изменений в ПЛИС необходимо подключать USRP к компьютеру с 

помощью разъема PCIe x4. 

 

Замечание Не подключайте одно и то же устройство к компьютеру 

одновременно с помощью MXI Express и Ethernet. 

 

Установка NI 294x/5x с помощью PCI Express 
Установите все необходимое программное обеспечение прежде чем подключать 

оборудование. 

1. Выключите компьютер и устройство USRP. Включите устройство USRP прежде чем 

включать компьютер. 

2. Подсоедините антенну или кабель к разъемам на лицевой панели устройства USRP 

как необходимо. 

3. Используйте набор MXI Express Interface Kit для подключения устройства USRP к 

компьютеру. 

http://www.ni.com/support
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1) Выберите, какой из наборов подходит Вам. 

• Если Вы используете набор для подключения к настольному ПК, 

следуйте инструкциям раздела Hardware Installation в документе Set Up 

Your MXI™ Express ×4 System, включенном в комплект его поставки. 

• При использовании набора для подключения к ноутбуку коснитесь 

одновременно платы NI ExpressCard-8360B и внешнего 

металлического корпуса устройства USRP. 

2) Подключите устройство MXI к USRP с помощью кабеля из комплекта. 

При использовании набора для ноутбука воспользуйтесь следующей схемой. 

 

1. Кабель из комплекта поставки набора 

для ExpressCard 

2. NI ExpressCard-8360B 

3. Слот ExpressCard  

4. Ноутбук 

4. Подключите источник питания AC/DC к устройству USRP. 

5. Включите источник питания в розетку. Нажмите кнопку включения PWR. 

6. Включите компьютер. 

Windows автоматически распознает устройство USRP. 
 

 

Дополнительная информация: Обратитесь к инструкции по установке набора 

MXI™ Express ×4  

  

http://www.ni.com/pdf/manuals/371976c.pdf
http://www.ni.com/pdf/manuals/371976c.pdf


NI USRP-294xR, USRP-295xR.  
Руководство пользователя  russia.ni.com 7 

Синхронизация устройств NI 294x/5x (опционально) 
Для создания многоканальных систем Вы можете синхронизовать два и более 

устройства NI 294x/5x, чтобы они использовали общий опорный сигнал и сигнал PPS. 

 

Замечание Для синхронизации нескольких NI 294x/5x рекомендуется 

использовать устройство CDA-2990. 

1. Подключите порт REF IN одного устройства USRP к порту REF OUT другого с 

помощью стандартного кабеля SMA (m)-SMA (m). 

2. Подключите порт PPS TRIG IN первого USRP к порту PPS TRIG OUT второго с 

помощью стандартного кабеля SMA (m)-SMA (m). 

Вы можете использовать порт PPS TRIG IN в качестве порта стандартного сигнала 

pulse-per-second или в качестве универсальной линии цифрового триггера. 

3. Подключите оба USRP к компьютеру или PXI с помощью кабеля MXI Express. 

 

Синхронизация с помощью CDA-2990 
 

1. Подключите порт REF IN одного устройства USRP к первому порту 10 MHz OUT 

устройства CDA-2990 с помощью стандартного кабеля SMA (m)-SMA (m). 

2. Подключите порт PPS TRIG IN первого USRP к порту PPS TRIG OUT устройства 

CDA-2990 с помощью стандартного кабеля SMA (m)-SMA (m). 

3. Повторите эти шаги для с другими USRP с использованием свободных портов CDA-

2990. 
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Установка NI 294x/5x с помощью Ethernet 
Установите все необходимое программное обеспечение прежде чем подключать 

оборудование. 

 

Замечание  Подключение NI 294x/5x с помощью Ethernet является 

дополнительной возможностью с ограниченным функционалом. 

Максимальный функционал достигается при подключении с помощью PCI 

Express. 

1. Не выключайте компьютер. 

2. Подсоедините антенну или кабель к разъемам на лицевой панели устройства USRP 

как необходимо. 

3. Подключите устройство USRP к компьютеру с помощью кабеля Ethernet. По 

умолчанию, порт 0 сконфигурирован для кабелей 1 Гигабит Ethernet, порт 1 – для 

кабелей 10 Гигабит Ethernet. 

 

Замечание  Пользователи Windows могут получать сообщения о 

безопасности и доступе в процессе установки. Примите сообщения. 

4. Подключите источник питания AC/DC к устройству USRP. 

5. Включите источник питания в розетку. Нажмите кнопку включения PWR. Windows 

автоматически распознает устройство USRP. 
 

Настройка сети (только для Ethernet) 
Устройство взаимодействует с компьютером по Гигабит Ethernet. Для корректной 

работы требуются следующие настройки. 
 

 

Замечание  IP адреса хост-компьютера и всех подключенных устройств 

USRP должны быть уникальными.  

Настройка статического IP адреса сетевой карты хост-компьютера  

IP адрес по умолчанию для NI 294x/5x - 192.168.10.2. 

1. Убедитесь, что хост-компьютер настроен на статический IP адрес. 

Возможно, Вам понадобится изменить сетевые настройки локальной сети 

компьютера с помощью Панели управления. Установите статический IP адрес на 

вкладке Properties для Internet Protocol Version 4 (TCP/IPv4). 

2. Настройте сетевую карту Ethernet на статический IP адрес в той же подсети, что и 

устройства USRP, как указано в таблице. 

Таблица 1. Статические IP адреса 
 

Компонент Адрес 

IP адрес сетевой карты Ethernet хост-компьютера 192.168.10.1 

Маска подсети хост-компьютера 255.255.255.0 

IP адрес устройства USRP по умолчанию 192.168.10.2 
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Замечание  NI-USRP использует протокол UDP для отправки пакетов при 

поиске локальных устройств. На некоторых системах файервол может 

блокировать рассылку пакетов UDP. NI рекомендует корректно настроить или 

временно отключить файервол. 

Изменение IP адреса 

Для изменения IP адреса Вы должны знать текущий адрес устройства и настроить сеть. 

1. Убедитесь, что Ваше устройство включено и подключено к компьютеру с помощью 

Гигабит Ethernet. 

2. Выберите Пуск»Все программы»National Instruments»NI-USRP»NI-USRP 

Configuration Utility чтобы открыть утилту конфигурации NI-USRP. 

3. Выберите вкладку Devices. 

Устройство появится в списке в левой части вкладки. 

4. Выберите из списка устройство, адрес которого хотите изменить. 

Убедитесь, что выбрано правильное устройство, если их несколько. 

IP адрес выбранного устройства отображается в поле Selected IP Address. 

5. Введите новый IP адрес в поле New IP Address. 

6. Нажмите Change IP Address или <Enter> для изменения IP адреса. 

Выбранный IP адрес устройства отображается в поле Selected IP Address. 

7. Утилита попросит подтвердить Ваш выбор. Нажмите OK если все верно или Cancel 

в противном случае. 

8. Утилита подтвердит изменения. Нажмите OK. 

9. Перезагрузите устройство с помощью отключения питания чтобы изменения 

вступили в силу. 

10. После изменения IP адреса следует перезагрузить устройство и нажать Refresh 

Device List в утилите для обновления списка устройств. 

 

Подтверждение сетевого соединения  

1. Выберите Пуск»Все программы»National Instruments»NI-USRP»NI-USRP 

Configuration Utility чтобы открыть утилиту настройки  NI-USRP. 

2. Выберите вкладку Devices. 

Устройство появится в списке в левой части вкладки. 

 

Замечание  Если Вашего устройства нет в списке, убедитесь, что оно 

включено и корректно подключено, затем кликните Refresh Device List 

чтобы заново просканировать систему. 

Настройка нескольких устройств с Ethernet 

Вы можете подключить несколько устройств следующими способами: 

• Несколько интерфейсов Ethernet — одно устройство для каждого интерфейса 

• Один интерфейс Ethernet — несколько устройств подключено к сетевому 

коммутатору. 
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Совет  Использование одного интерфейса Гигабит Ethernet для нескольких 

устройств может снижать пропускную способность. Для максимальной 

пропускной способности NI рекомендует подключать не более одного 

устройства к каждому интерфейсу Ethernet.  

Несколько интерфейсов Ethernet 

Для настройки нескольких устройств, подключенных к отдельным интерфейсам 

Гигабит Ethernet, назначьте каждому интерфейсу Ethernet отдельную подсеть и 

назначьте каждому устройству - IP адрес из соответствующей подсети, как показано в 

таблице. 

Таблица 2.  Настройка нескольких интерфейсов 
 

Устройство IP адрес хоста Маска подсети  IP адрес устройства  

USRP 0 192.168.10.1 255.255.255.0 192.168.10.2 

USRP 1 192.168.11.1 255.255.255.0 192.168.11.2 

 

Единый интерфейс Ethernet — несколько устройств через коммутатор 

Вы можете подключить несколько устройство USRP к компьютеру с помощью сетевого 

коммутатора, позволяющего подключать несколько устройств к одному адаптеру 

Гигабит Ethernet. 

Назначьте подсеть для компьютера и адрес для каждого устройства в этой подсети, как 

показано в следующей таблице. 
 

Таблица 3.  Настройка единого интерфейса на хосте с коммутатором 
 

Устройство IP адрес хоста Маска подсети IP адрес устройства 

USRP 0 192.168.10.1 255.255.255.0 192.168.10.2 

USRP 1 192.168.10.1 255.255.255.0 192.168.10.3 

 
 

Программирование NI 294x/5x   
Вы можете использовать драйвер NI-USRP для создания телекоммуникационных 

приложений для NI 294x/5x. 

Устройства NI 294x/5x являются целевыми устройствами для LabVIEW FPGA, с 

поддержкой разработки собственных программ для ПЛИС и настройки устройств с 

помощью Instrument Design Libraries. Воспользуйтесь шаблонными проектами для 

быстрого старта разработки приложений. 

 

Замечание  Для программирования ПЛИС следует использовать 

подключение PCIe x4. Вы не сможете программировать ПЛИС при 

подключении по 1G/10G ETH. 
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Драйвер NI-USRP  
Драйвер NI-USRP представляет набор виртуальных приборов (VI) и свойств для работы 

с NI 294x/5x, включая настройку, управление и другие специфические для устройства 

функции. Обратитесь к помощи NI-USRP Help за информацией о том, как использовать 

драйвер для Вашего приложения. 

 

Примеры проектов NI-USRP 
Программное обеспечение NI-USRP содержит примеры проектов, служащие отправной 

точкой для разработки приложений. Вы можете открыть эти проекты из LabVIEW, 

выбрав пункт меню File»Create Project»NI-USRP . 

Для изменения поведения ПЛИС на Вашем компьютере должен быть установлен 

модуль LabVIEW FPGA Module. 

 

Примеры NI-USRP 
Примеры драйвера демонстрируют часть функционала NI 294x/5x. Их можно 

использовать по отдельности или интегрировать в Вашу систему. NI-USRP включает 

стартовые примеры и другие примеры для программно-определяемых радиосистем. 

Доступ к примерам NI-USRP осуществляется из следующих мест: 

• Из меню Пуск: Пуск»Все программы»National Instruments»NI-USRP» 

Examples. 

• В LabVIEW из палитры Functions»Instrument I/O»Instrument Drivers»NI‑USRP» 

Examples. 
 

 

Замечание  NI Example Finder не включает примеры NI-USRP. Обратитесь к 

меню Пуск или ка палитре функций LabVIEW. 

Дополнительные примеры различного уровня интеграции доступны в сообществе на 

странице  ni.com/usrp. 

 
Проверка устройства (дополнительно) 
Запустите программу-пример чтобы убедиться, что устройство передает и принимает 

сигналы и правильно подключено к компьютеру. 

1. Создайте шаблонный проект NI-USRP в LabVIEW с помощью File»Create 

Project»NI-USRP. 

2. Запустите Full Duplex Streaming (Host) VI. 

Если устройство передает и принимает сигналы, на графиках отображаются данные. 

3. Нажмите STOP для завершения проверки. 
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Устранение неполадок   
В данном разделе приведены инструкции по устранению неполадок. Если проблему не 

удалось устранить после описанных ниже действий, свяжитесь с технической 

поддержкой NI или обратитесь к странице ni.com/support. 
 

Устранение неполадок с устройством 

Следует ли обновлять прошивку ПЛИС? 

Устройства NI 294x/5x поставляются с прошивкой ПЛИС, совместимой с драйвером NI-

USRP. Для совместимости с более актуальной версией драйвера может понадобиться 

обновление прошивки ПЛИС. 

Носитель с драйвером содержит также утилиту NI-USRP Configuration Utility, 

используемую для обновления прошивки. 

 

Замечание  Если Вы используете устройство NI 294x/5x как целевое 

устройство LabVIEW FPGA (target), не обновляйте прошивку ПЛИС. Вместо 

этого используйте шаблонные проекты для начала работы по изменению кода 

ПЛИС. 

Обновление прошивки устройства NI 294x/5x и ПЛИС (дополнительно) 

Прошивка ПЛИС для устройства NI 294x/5x хранится во внутренней памяти 

устройства. Вы можете перезаписать прошивку ПЛИС или устройства с помощью 

утилиты  NI-USRP Configuration Utility и с помощью подключения Ethernet, но Вы не 

сможете создавать собственный код ПЛИС при подключении по Ethernet. 

1. Если Вы еще этого не сделали, подключите хост компьютер с помощью порта 

Ethernet. 

2. Выберите Пуск»Все программы»National Instruments»NI-USRP»NI-USRP 

Configuration Utility для доступа к утилите NI-USRP Configuration Utility. 

3. Выберите вкладку N2xx/NI-29xx Image Updater. Утилита автоматически заполнят 

поля Firmware Image и FPGA Image путями к файлам прошивок по умолчанию. 

Для использования других файлов, нажмите Browse и выберите нужный файл. 

4. Убедитесь, что пути прописаны корректно. 

 

5. Нажмите Refresh Device List для поиска устройств USRP и обновления списка. 

Если Ваше устройство не значится в списке, убедитесь, что устройство включено и 

правильно подключено к компьютеру. 

Если Ваше устройство все еще не значится в списке Вы можете добавить устройство 

в список вручную. Нажмите Manually Add Device, введите IP адрес устройства и 

нажмите OK. 

6. Выберите устройство для обновления из списка. 

7. Убедитесь, что выбранный файл соответствует ревизии и модели устройства, 

прошивку которого Вы хотите обновить. 

http://www.ni.com/support
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8. Нажмите WRITE IMAGES. 

9. Появится диалоговое окно подтверждения. Подтвердите выбор нажатием OK. 

10. По окончании загрузки появится диалоговое окно с запросом перезагрузки 

устройства. Перезагрузка применяет новые прошивки. Нажмите OK для 

перезагрузки устройства. 

 

Замечание  Утилита не будет отвечать на действия пользователя во 

время проверки корректности перезагрузки. 

11. Закройте утилиту. 
 

Почему устройство USRP не отображается в MAX? 

NI MAX поддерживает только устройства NI 294x/5x при настроенном соединении по 

PCI Express. При использовании устройства NI 294x/5x, подключенного по Ethernet, 

следует использовать утилиту NI-USRP Configuration Utility. 

Откройте утилиту NI-USRP Configuration Utility из меню Пуск»Все программы» 

National Instruments»NI-USRP»NI-USRP Configuration Utility. 
 

Почему устройство не включается? 
• Убедитесь в исправности источника питания, попробуйте другой источник питания 

с помощью замены на другой. 

• Убедитесь в нажатии кнопки питания на лицевой панели устройства. 

 

Почему устройство USRP не отображается в NI-USRP 
Configuration Utility? 

Проверьте подключение USRP к компьютеру. 

• При подключении по кабелю MXI Express, убедитесь, что устройство USRP 

включено и подключено к компьютеру до включения компьютера. 

• При подключении по Ethernet, убедитесь, что USRP подключено к компьютеру с 

помощью адаптера, совместимого с Гигабит Ethernet. Убедитесь, что адаптеру 

Вашего компьютера назначен статический IP адрес вида 192.168.10.1. Полный 

запуск устройства может занимать до 15 секунд.  
 
 
 

Почему в NI-USRP Configuration Utility вместо NI 294x/5x  
отображается USRP2? 

Такое поведение может быть вызвано неправильными настройками IP адреса на 

компьютере. Проверьте IP адрес и запустите утилиту NI-USRP Configuration Utility 

повторно. 

Также такое поведение может быть вызвано старой версией прошивки ПЛИС или 

устройства. Обновите прошивку ПЛИС и устройства с помощью утилиты NI-USRP 

Configuration Utility. 
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Почему примеры для NI-USRP не видны в NI Example Finder? 

NI-USRP не устанавливает примеры в NI Example Finder. Ищите примеры NI-USRP в 

следующих местах: 

• Из меню Пуск»Все программы»National Instruments»NI-USRP» Examples. 

• В LabVIEW в палитре Functions»Instrument I/O»Instrument 

Drivers»NI‑USRP»Examples. 
 

Устранение сетевых неполадок 

Почему USRP не отвечает на запросы ping (ICMP echo)? 

Устройство должно отвечать на запросы echo протокола Internet Control Message 

Protocol (ICMP). Откройте командную строку Windows и введите команду ping 

192.168.10.2, где 192.168.10.2  - IP адрес Вашего устройства USRP. Если Вы не 

получаете ответов, проверьте, что сетевая карта хост-компьютера настроена на 

статический IP адрес, соответствующий маске подсети и IP адресу устройства. Также 

убедитесь, что IP адрес устройства настроен корректно. 

Дополнительная информация:  Изменение IP адреса на странице 8. 

Почему утилита NI-USRP Configuration Utility не включает в 

список мое устройство? 

Если утилита NI-USRP Configuration Utility не включает в список Ваше устройство, 

сделайте поиск по IP адресу. 

1. Пройдите в папку  <Program Files>\National Instruments\NI-USRP\. 

2. <Shift>-правый клик на папке Utilities, и выберите Open command window here из 

контекстного меню чтобы открыть командную строку Windows. 

3. Введите в командной строке uhd_find_devices --args=addr=192.168.10.2, 

где 192.168.10.2 - IP адрес вашего устройства USRP. 

4. Нажмите <Enter>. 

Если команда uhd_find_devices не возвращает список, возможно, файервол 

блокирует рассылку пакетов по UDP. По умолчанию Windows устанавливает и 

включает файервол. Чтобы разрешить рассылку пакетов UDP для устройства, 

отключите файервол для адаптера, соответствующего Вашему устройству. 

Почему IP адрес устройства не сбрасывается к значению по 
умолчанию? 

Возможно, Ваше устройство и хост-компьютер находятся в разных подсетях. Вы 

можете перезагрузить Ваше устройство в безопасном (read-only) режиме, в котором IP 

адрес будет сброшен к 192.168.10.2. 

1. Вскройте устройство, после необходимых электростатических предосторожностей. 

2. Найдите переключатель безопасного режима, кнопку S2, внутри. 

3. Нажмите и удерживайте кнопку безопасного режима во время перезагрузки 
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устройства путем отключения питания. 

4. Продолжайте удерживать кнопку пока светодиоды на лицевой панели устройства не 

будут светиться постоянно. 

5. Находясь в безопасном режиме, запустите утилиту NI-USRP Configuration Utility 

чтобы изменить IP адрес со значения по умолчанию, 192.168.10.2, на новое 

значение. 

6. Отключите и вновь подключите питание к устройству без нажатия кнопки 

безопасного режима для загрузки в обычном режиме. 
 

 

Замечание  NI рекомендует использовать отдельную сеть без других 

подключенных устройств USRP во избежание конфликтов IP адресов. Кроме 

того, убедитесь, что адрес хост-компьютера, на котором запущена утилита NI-

USRP Configuration Utility, отличается от IP адреса по умолчанию 

192.168.10.2 и от нового адреса, которое Вы устанавливаете на устройстве.  
 

 

Замечание  Если IP адреса устройства и хост-компьютера находятся в разных 

подсетях, хост-система и утилита не могут общаться с устройством. Например, 

утилита может распознавать, но не может настраивать IP адрес устройства 

192.168.11.2, подключенного к хост-компьютеру со статическим адресом 

192.168.10.1, и маской подсети 255.255.255.0. Для взаимодействия с 

таким устройством и его настройки измените статический адрес сетевого 

адаптера на соответствующий маске подсети, например, 192.168.11.1, или 

измените маску подсети адаптера для распознавания более широкого 

диапазона адресов, например, 255.255.0.0. 
 

Дополнительная информация: Изменение IP адреса на странице 8. 

Почему устройство не подключается к хосту?  

Для подключения устройства USRP сетевая карта хост-компьютера должна быть 

стандарта Гигабит Ethernet. 

Убедитесь, что соединение активно и оба устройства включены. 

Горящий зеленый индикатор в верхнем левом углу порта Гигабит Ethernet на лицевой 

панели устройства показывает подключение по Гигабит Ethernet. 
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Лицевые панели, задние панели, разъемы   
 

Прямые подключения к NI 294x/5x 
NI 294x/5x является чувствительным СВЧ прибором, чувствительным к 

электростатическим разрядам и импульсным помехам. Прежде чем производить прямые 

подключения к NI 294x/5x убедитесь в соблюдении следующих мер предосторожности во 

избежание повреждения устройства. 
 

 

Внимание  Подключать внешние сигналы можно только при включенном 

устройстве. Подключение внешних сигналов к выключенному устройству 

может повредить его. 

• Убедитесь, что Вы заземлены при любых операциях с кабелями и антеннами, 

подключаемыми к разъемам TX1 RX 1 или RX2 устройства NI 294x/5x. 

• При использовании неизолированных устройств, таких как неизолированная 

антенна, убедитесь, что эти устройства используются в окружении без опасности 

статических разрядов. 

• При использовании активных устройств, таких как усилитель или коммутатор, 

подключенных к портам TX1 RX 1 или RX2 устройства NI 294x/5x, убедитесь в 

отсутствии наводок и утечек, превышающих характеристики по постоянному и 

переменному току как разъемов NI 294x/5x, так и подключаемого устройства. 

 

Лицевые панели NI USRP-294xR, USRP-295xR 
Рисунок 1. Лицевая панель NI USRP-294xR, USRP-295xR 

 
 
 
 
 
 
 
 

Таблица 4. Разъемы лицевой панели NI USRP-294xR/295xR 

Разъем Назначение 

JTAG Порт USB для соединения хост-компьютера к ПЛИС устройства с 

целью разработки и отладки. На данный момент возможность 

настройки или программирования ПЛИС пользователем с помощью 

разъема JTAG отсутствует. 

RF 0 TX1 RX1 Входной и выходной терминал для радиосигнала. TX1 RX1 – разъем 

SMA (f) с импедансом 50 Ω, несимметричный входной или выходной 

канал. 

RX2 Входной терминал для радиосигнала. RX2 – разъем SMA (f) с 

импедансом 50 Ω, несимметричный входной канал. 
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Таблица 4. Разъемы лицевой панели NI USRP-294xR/295xR (продолжение) 
 

Разъем Назначение 

AUX I/O Порт цифровых линий общего назначения, управляемый с ПЛИС. 

RF 1 TX1 RX1 Входной и выходной терминал для радиосигнала. TX1 RX1 – разъем 

SMA (f) с импедансом 50 Ω, несимметричный входной или выходной 

канал. 

RX2 Входной терминал для радиосигнала. RX2 – разъем SMA (f) с 

импедансом 50 Ω, несимметричный входной канал. 

 

 

Замечание  Описанное в следующей таблице поведение светодиодов 

справедливо при использовании API драйвера NI-USRP с применением 

стандартной прошивки. При использовании LabVIEW FPGA Вы можете 

самостоятельно задавать логику работы светодиодов. 

Таблица 5. Светодиоды NI USRP-294xR/295xR 
 

Светодиод Описание Цвет Режим Значение 

RF 0 TX1 

RX1 

Статус передатчика 

модуля 

Выкл — Модуль не активен 

Красный Постоянно Модуль передает данные 

Зеленый Постоянно Модуль принимает 

данные 

RX2 Статус приемника 

модуля 

Выкл — Модуль не принимает 

Зеленый Постоянно Модуль принимает 

REF Статус опорного 

сигнала 

Выкл — Нет опорного сигнала 

или модуль не 

синхронизирован с 

внешним опорным 

сигналом 

Зеленый Моргает Модуль не 

синхронизирован с 

опорным сигналом 

Постоянно Модуль 

синхронизирован с 

опорным сигналом 
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Таблица 5. Светодиоды NI USRP-294xR/295xR (продолжение) 
 

Светодиод Описание Цвет Режим Значение 

PPS Статус сигнала 

PPS (импульс в 

секунду) 

Выкл — Нет сигнала PPS или 

модуль не 

синхронизирован с 

сигналом 

Зеленый Моргает Модуль не 

синхронизирован с 

сигналом временной 

метки PPS 

Постоянно Модуль 

синхронизирован с 

сигналом PPS 

GPS Статус 

синхронизации 

GPSDO 

Выкл — GPSDO отсутствует или 

не синхронизирован 

Зеленый Постоянно GPSDO синхронизирован 

LINK Статус 

соединения с 

хост-

компьютером 

Выкл — Соединение с хост-

компьютером отсутствует 

Зеленый, 

желтый или 

красный 

Постоянно Хост активно 

обменивается данными с 

устройством 

RF 1 TX1 

RX1 

Статус 

передатчика 

Выкл — Модуль не активен 

Красный Постоянно Модуль передает данные 

Зеленый Постоянно Модуль принимает 

RX2 Статус приемника Выкл — Модуль не активен 

Зеленый Постоянно Модуль принимает 

 
Задние панели NI USRP-294xR/295xR 
 

Рисунок 2. Задняя панель NI USRP-294xR/295xR 
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Таблица 6. Разъемы задней панели NI USRP-294xR/295xR 
 

Разъем Назначение 

PWR Разъем внешнего питания, от 9 до 16 В, 6 А постоянного тока. 

1G/10G ETH Порт Ethernet, совместимый с модулями 1G SFP и 10G SFP+. При 

использовании модуля 1G ETH, порт совместим с кабелями Гигабит 

Ethernet (категории 5, 5e, 6). 

REF OUT Выходной терминал внешнего опорного сигнала для сигнала 

гетеродина. Разъем REF OUT имеет тип SMA (f) с импедансом 50 Ω, 

несимметричный выход. Сигнал на этом разъеме 10 МГц, 3.3 В. 

REF IN Входной терминал внешнего опорного сигнала для сигнала 

гетеродина. Разъем REF IN имеет тип SMA (f) с импедансом 50 Ω, 

несимметричный вход. REF IN принимает сигнал меандра или синуса 

частотой 10 МГц с минимальным уровнем 0 дБм (амплитуда 0.316 В) 

и максимальным уровнем 15 дБм (амплитуда 1.78 В). 

PCIe x4 Порт соединения по шине PCI Express Generation 1, x4 с помощью 

кабеля MXI Express. 

PPS TRIG 

OUT 

Выходной терминал сигнала временной синхронизации (PPS). 

Разъем PPS TRIG OUT имеет тип SMA (f) с импедансом 50 Ω, 

несимметричный. Сигнал от 0 до 3.3 В стандарта TTL. Этот порт 

также можно использовать в качестве выхода триггера (TRIG OUT), с 

помощью сигнала PPS Trig Out I/O. 

PPS TRIG IN Входной терминал сигнала временной синхронизации (PPS). 

Разъем PPS TRIG IN имеет тип SMA (f) с импедансом 50 Ω, 

несимметричный. Разъем PPS IN принимает сигналы от 0 до 3.3 В 

TTL или от 0 до 5 В TTL. Этот порт также можно использовать в 

качестве входа триггера (TRIG IN), под управлением драйвера NI-

USRP. 

GPS ANT Входной терминал сигнала с антенны GPS. Разъем GPS ANT имеет 

тип SMA (f) с импедансом 50 Ω, с максимальным сигналом -15 дБм 

и выходом +5 В постоянного тока для питания активной антенны. 
 

Внимание! Не терминируйте разъем GPS ANT если не 

используете его. 
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Разъем GPIO 
 

Таблица 7. Распиновка разъема GPIO NI USRP-294xR/295xR 
 

Разъем AUX I/O  Ножка Наименование 

терминала           

NI-USRP 

Наименование узла  

USRP RIO (LV FPGA) 

 

 
 
 

 

1 +3.3 V +3.3 V 

2 GPIO 0 AUX I/O 0 

3 GPIO 1 AUX I/O 1 

4 GPIO 2 AUX I/O 2 

5 GPIO 3 AUX I/O 3 

6 GPIO 4 AUX I/O 4 

7 GPIO 5 AUX I/O 5 

8 GPIO 6 AUX I/O 6 

9 GPIO 7 AUX I/O 7 

10 GPIO 8 AUX I/O 8 

11 GPIO 9 AUX I/O 9 

12 GPIO 10 AUX I/O 10 

13 GPIO 11 AUX I/O 11 

14 0 V 0 V 

15 0 V 0 V 

 
 
 



 

Документация и файлы справки онлайн   
 

 

Документ NI-USRP Help – это HTML версия традиционного руководства 

пользователя с дополнительной информацией об основах радиоизмерений, 

особенностях устройств и программирования с помощью драйвера NI-USRP. 

Техническая поддержка по всему миру    
Веб-сайт National Instruments – это Ваш надежный источник технической поддержки. 

На странице ni.com/support, Вы можете получить доступ к материалам от устранения 

неполадок до руководств по разработке приложений, ресурсам для самостоятельного 

изучения, а также к помощи по телефону или электронной почте от инженеров 

технической поддержки. 

Обратитесь к странице ni.com/services для получения услуг NI Factory Installation 

Services, ремонта, расширенной гарантии и др. 

Обратитесь к странице ni.com/register для регистрации Ваших продуктов NI. 

Регистрация продукта облегчает получение технической поддержки, а также 

обеспечивает своевременное информирование об обновлениях от NI. 

На странице ni.com/certification Вы найдете информацию о соответствии продуктов NI 

международным стандартам ЭМС и безопасности.  

Если Ваш продукт поддерживает калибровку, Вы можете запросить сертификат на 

странице ni.com/calibration. 

Для технической поддержки по телефону в США, заполните форму на странице 

ni.com/support или позвоните 1 866 ASK MYNI (275 6964). За пределами США 

обратитесь в удобный Вам международный офис NI, полный список офисов и 

контактов доступен на странице ni.com/niglobal . 
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торговыми марками и торговыми названиями соответствующих компаний. Для получения информации о патентах 
компании NI, обратитесь по ссылке Help>>Patents вашего программного обеспечения, ознакомьтесь с документом 
patents.txt на вашем CD или посетите страничку ni.com/patents. 
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